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QUARKXPRESS 9.1 README

QuarkXPress 9.1 ReadMe
QuarkXPress® 9 offers a wealth of new features, including conditional styles, callouts,
bullets and numbering, Story Editor view, and more.
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SYSTEM REQUIREMENTS

System requirements
System requirements: Mac OS
Software
• Mac OS® 10.5.8 (Leopard®), Mac OS 10.6.8 (Snow Leopard®), Mac OS 10.7.x (Lion™), or
later
• Tested on Citrix

Hardware
• Mac® Intel® processor
• 2GB RAM (1GB minimum)
• 2GB hard disk space

Optional
• An Internet connection for activation
• DVD-ROM drive for installation from DVD (not required for installation from download)

System requirements: Windows
Software
• Microsoft® Windows® XP (Service Pack 2 or 3), Windows Vista® 1.0, or Windows 7
• Microsoft .NET Framework 3.5 SP1
• Tested on Citrix

Hardware
• 2GB RAM (1GB minimum)
• 1GB hard disk space
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Optional
• An Internet connection for activation
• DVD-ROM drive for installation from DVD (not required for installation from download)
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INSTALLING: MAC OS

Installing: Mac OS
To install QuarkXPress:
1 Disable any virus protection software. If you are concerned about a virus infecting your
computer, run a virus check on the installer file, then disable your virus detection software.
2 Double-click the installer icon and follow the instructions on the screen.

Performing a silent installation
The silent installation feature lets users install QuarkXPress on their computers over a
network without having to follow step-by-step instructions. This feature is useful for large
group installations when performing manual installations is cumbersome.

Preparing for silent installation: Mac OS
To enable Mac OS users to perform a silent installation on their computers, an administrator
must make the following modifications:
1 Copy everything from the disc or disk image that contains the installer to an empty folder
on the local hard disk.
2 Using the local copy of the installer, install QuarkXPress on the local hard disk. The installer
creates a "setup.xml" file in the folder where the installer is located.
3 Share the folder that contains the installer and the "setup.xml" file with users who are
licensed to install QuarkXPress.

Performing a silent installation: Mac OS
To perform a silent installation on Mac OS, an end user must follow these steps:
1 Copy the installer folder that contains the "setup.xml" file to your computer.
2 Double-click the QuarkXPress installer icon and follow the instructions on the screen.
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Adding files after installation: Mac OS
To add files after installation, double-click the installer icon. Use the Custom Install list
to select the items to install.
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INSTALLING: WINDOWS

Installing: Windows
To install QuarkXPress:
1 Disable any virus protection software. If you are concerned about a virus infecting your
computer, run a virus check on the installer file, then disable your virus detection software.
2 Double-click the installer icon and follow the instructions on the screen.

Performing a silent installation
The silent installation feature lets users install QuarkXPress on their computers over a
network without having to follow step-by-step instructions. This feature is useful for large
group installations when performing manual installations is cumbersome.

Preparing for silent installation: Windows
To enable Windows users to perform a silent installation on their computers, an
administrator must make the following modifications:
1 Copy everything from the disc or disk image that contains the installer to an empty folder
on the local hard disk.
2 Using the local copy of the installer, install QuarkXPress on the local hard disk. The installer
creates a "setup.xml" file in the folder where the installer is located.
3 Open the "silent.bat" file in a text editor and make sure the path of the "setup.xml" file is
in the first line as follows: '[network path of setup.exe file]' /s /v'/qn'
4 Share the folder that contains the installer and the "setup.xml" file with users who are
licensed to install QuarkXPress.

Silent installation: Windows
To perform a silent installation on Windows, an end user must follow these steps:
1 Navigate to the shared folder that contains the "setup.xml" and "silent.bat" files.
2 Double-click the "silent.bat" file and follow the instructions on the screen.
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Adding files after installation: Windows
To add files after installation:
1 Double-click the "setup.exe" icon.
The Setup dialog box displays.
2 Click Next.
The Program Maintenance screen displays.
• Click Modify to choose the files to install. You can install new files or remove previously
installed files.
• Click Repair to correct minor issues related to installed files. Use this option if you
experience issues with missing or damaged files, shortcuts, or registry entries.
3 Click Next.
• If you clicked Modify in the previous dialog box, the Custom Setup screen displays. Make
the appropriate modifications, then click Next. The Ready to Modify the Program screen
displays.
• If you clicked Repair in the previous dialog box, the Ready to Repair the Program screen
displays.
4 Click Install.
5 Click Finish when the system notifies you that the process is complete.
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UPGRADING

Upgrading
To upgrade QuarkXPress to this version:
1 Disable any virus protection software. If you are concerned about a virus infecting your
computer, run a virus check on the installer file, then disable your virus detection software.
2 Double-click the installer icon and follow the instructions on the screen.
3 When the Validation Code screen displays, choose Upgrade from the Installation Type
drop-down menu. If you have your upgrade validation code, enter it in the Enter your
validation code fields. If you do not have an upgrade validation code, click Get validation
code to go to the Quark Web site, follow the instructions on the screen to get the validation
code, and then enter the validation code in the Enter your validation code fields.
4 Click Continue and follow the instructions on the screen.
The installer installs a new copy of QuarkXPress. It does not replace the earlier version.
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UPDATING

Updating
The installer will update earlier versions of QuarkXPress 9.x to this version. To update
QuarkXPress:
1 Disable any virus protection software. If you are concerned about a virus infecting your
computer, run a virus check on the Installer and then disable your virus detection software.
2 Make a copy of the application folder on your hard drive to ensure that you have a working
copy of the software if you encounter issues during the update.
3 Make sure the names of the application folder and the application have not changed since
installation.
4 Double-click the Installer icon and follow the instructions on the screen.
• Windows: The installer locates your installed copy of QuarkXPress and updates it to this
version.
• Mac OS: If your installed copy of QuarkXPress is in the default location, the installer updates
it. If your installed copy of QuarkXPress is not in the default location and you want to
update it, click the Customize button when it displays, click in the Location column for
the application, choose Other, and navigate to the location of the existing installation.
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INSTALLING OR UPGRADING WITH QLA

Installing or upgrading with QLA
Quark® License Administrator (QLA) is software that manages licensed Quark products.
If you purchased an educational site license or a commercial site license, you most likely
received a QLA CD-ROM when you purchased QuarkXPress. QLA must be installed on
your network before you install QuarkXPress.
If QLA is already installed and you are installing QuarkXPress, the License Server Details
dialog box displays after you enter your registration information. Before proceeding, verify
that you have the information you need to enter values in the following fields:
• License Server Host Name or IP Address: Enter the IP address or server name for the
server you have designated as the license server. The license server handles requests from
license clients.
• License Server Port: Enter the value for the license server port. This number is determined
when the QLA software is registered online. The license server port is the port through
which license server requests flow.
• Backup License Server Host Name or IP Address: Enter the IP address or server name for
the server you have designated as the backup license server.
• Backup License Server Port: Enter the value for the backup license server port.
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Registering
To register your copy of the application, visit the "Online registration" page of the Quark
Web site (see Contacting Quark). If you cannot register online, see Contacting Quark for
contact information.
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ACTIVATING

Activating
If you have a single-user copy of QuarkXPress, you must activate it. To activate QuarkXPress
when you launch it, click Activate Now.
If you do not want to activate QuarkXPress when you launch it, click Continue.QuarkXPress
presents the option to activate it each time you launch the application until you activate
it.
If you do not activate QuarkXPress, you can use it for 30 days after installation; after 30
days, the product runs in demonstration mode and must be activated before it will run as
a full version.
If you cannot activate online, see Contacting Quark for contact information.
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Uninstalling
If the uninstaller detects a running instance of the application, an alert displays. Close the
application before you begin to uninstall.

Uninstalling: Mac OS
To uninstall QuarkXPress, open the "Applications" folder on your hard drive (or the folder
in which QuarkXPress was installed) and drag the QuarkXPress folder to the trash.

Uninstalling: Windows
To uninstall QuarkXPress:
1 Choose Start > All Programs > QuarkXPress > Uninstall.
2 Click Yes. The uninstaller gathers the information necessary for uninstalling and then an
alert displays to notify you that the contents of the QuarkXPress application folder will
be deleted.
3 Click Yes to continue or No to cancel.
You can also uninstall by running the installer again.
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CHANGES IN THIS VERSION

Changes in this version
This version of QuarkXPress includes the following changes.
You cannot open files saved in QuarkXPress 9.1 or later directly in QuarkXPress 9.0.
However, you can export a project in QuarkXPress 9.0 format with the File > Export >
Layouts as Project command.

App Studio
The App Studio feature lets you create and publish content that your customers can
purchase and download from within your own custom app.

App Factory (Mac OS only)
The App Factory application lets you create a customized app for the iPad®, for distribution
through the Apple® App Store. You can use your custom app to distribute the issues you
create with App Studio.

Trim View
The Trim View command (View menu) simulates what the page will look like when
trimmed by cropping any items that extend beyond the page boundary. You can control
the color of the pasteboard that displays when this item is selected in the Display pane
of the Preferences dialog box (QuarkXPress/Edit > Preferences).

Hide Suppressed
The Hide Suppressed command (View menu) hides all items for which the Suppress
Output box is checked in the Box, Line, Picture, or Layout pane of the Modify dialog
box, as well as layers for which Suppress Output is checked in the Attributes dialog box.
In addition, this option hides underlines on hyperlinks, hyperlink anchors, index markers,
and the text overflow symbol.

View sets
The View menu provides various options for how a layout displays. You can display or
hide guides, grids, invisible characters, visiual indicators, and more. The View Sets feature
lets you store and recall different combinations of these settings.
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CHANGES IN THIS VERSION

Style sheet to reflow tag mapping
You can now map style sheets to tags in a reflow article. This makes it much easier to
prepare existing styled content for distribution in the ePUB and Blio eBook formats. For
more information, see "Mapping style sheets to Reflow styles." in A Guide to QuarkXPress.

Panning while a Pen tool is selected
To pan the layout while a Pen tool is selected, press Shift+Space and then click and drag.

Support for PSD files in Job Jackets rules
You can now create rules that evaluate Photoshop (PSD) files.
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KNOWN AND RESOLVED ISSUES

Known and resolved issues
For lists of known issues and resolved issues in this version of the software, visit the Quark
Web site at www.quark.com, euro.quark.com, or japan.quark.com. Product documentation,
including lists of known and resolved issues, is available under Support > Product
Documentation.
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Contacting Quark
If you have questions about installing, configuring, or using this software, please contact
Quark Inc.

In the Americas
For technical support, please use our free live online chat at support.quark.com, call the
incident-based support line at 800.676.4575 between 12:00 a.m. Monday and 6:00 p.m.
Friday (Mountain Time), or send an e-mail message to techsupp@quark.com.
For product information, please visit the Quark Web site at www.quark.com, or send an
e-mail message to cservice@quark.com.

Outside the Americas
In Europe, technical support is available by live online chat at support.quark.com or
euro.quark.com and by phone between 8.30 and 17.30 Central European Time, Monday to
Friday. Use one of the following local toll-free numbers:
• Belgium: 0800-77-296
• Denmark: 8088-7070
• France: 0800-91-3457
• Germany: 0800-180-0101
• Ireland: 1800-55-0241
• Italy: 800-87-4591
• Luxembourg: 8002-3861
• The Netherlands: 0800-022-7695
• Norway: 800-1-4398
• Spain: 800-1-4398
• Sweden: 020-790-091
• Switzerland: 0800-55-7440
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CONTACTING QUARK

• UK and Ireland: 0808-101-7082
In some cases, a toll-free number may not be accessible via a mobile device. In such cases,
please use a land line.
For e-mail support in Europe, use live online chat or one of the following addresses:
• English: eurotechsupp@quark.com
• German: techsupportde@quark.com
• French: techsupportfr@quark.com
• Italian: techsupportit@quark.com
• Spanish: techsupportes@quark.com
In Australia, please use live online chat or call 1 800.670.973 between 10:00 a.m. and 7:00
p.m. Sydney Time (AEST), Monday through Friday, or send an e-mail message to
austechsupp@quark.com.
In Japan, please use live online chat or call (03) 3476–9440 (Monday through Friday, 10:00
am – 12:00 pm and 1:00 pm – 5:00), send a fax to (03) 3476–9441, or visit the Japanese
Quark Web site at japan.quark.com.
In countries not listed above, please use live online chat or contact your Quark Full Service
Distributor for technical support. For a list of Quark Full Service Distributors, visit the
Quark Web site at www.quark.com, euro.quark.com, or japan.quark.com.
For product information, please visit the Quark Web site at euro.quark.com or
japan.quark.com, or send an e-mail message to one of the following addresses:
• English: eurocservice@quark.com
• German: custservice.de@quark.com
• French: custservice.fr@quark.com
• Italian: custservice.it@quark.com
• Spanish: custservice.es@quark.com
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Legal notices
©1986-2022 Quark, Inc. and its licensors. All rights reserved.
Protected by the following United States Patents: 5,541,991; 5,907,704; 6,005,560;
6,052,514; 6,081,262; 6,633,666 B2; 6,947,959 B1; 6,940,518 B2; 7,116,843; and other
patents pending.
Quark, the Quark logo, QuarkXPress, QuarkCopyDesk, Quark Publishing System, and QPS
are trademarks or registered trademarks of Quark, Inc. and its affiliates in the U.S. and/or
other countries. All other marks are the property of their respective owners.
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